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Abstract: Power BI has taken the world of business intelligence, data visualization and analytics by storm. Power BI is an online
service that enables searching data, transforming it, visualizing it, and sharing the developed reports and dashboards with other
users in the same or different department/organizations or even with the general public. As of February 2017, more than
200,000 organizations across 205 countries are using Power BI. Power Bl is having a free option that has adequate features and
Jfunctionality , it has become a serious contender for use as a business intelligence platform in small and medium organizations.
One of the innovative features of Power Bl is its Quick Insights feature (Michael Hart, 2017) that is built on a growing set of
advanced analytical algorithms. After uploading a dataset to Power BI, a click of a button can be used to invoke this feature that
automatically builds many reports based on its analysis of the data, without any human intervention being required. This also
helps reduce human errors, in calculations and statistical techniques, which lead to un-verifiable research. Accepting even Excel
spreadsheets as input, Power Bl is easy to use and ripe for adoption as a platform for Research Data Analysis. In this paper, an
attempt has been made to show how easily a dataset of research data can be transformed by Power BI into a set of analytical
reports and dashboards, and which can be shared with ease.
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I. INTRODUCTION

Road accident is world main problem. Every day we watch the news of road accident on the TV, Internet. The main causes of road
accident are human behavior. The major causes of road accident are human carelessness in our country. Under the causes of road
accident the carelessness is one of the most important factors in road accident. In road accident cause include breaking the traffic
rules, using the mobile phone when driving .the another causes of road accident is inexperience driver and untrained drivers. At
night time most of the driver drives the vehicle under the influence of alcohol it is also main factors which contribute in road
accident.

High speed, increasing no of vehicles, carelessness among road user and many other reasons are said to be linked to road accident.
The problem of deaths and injuries as a result of accidents is to be a global phenomenon. Traffic safety has been a serious concern
since the start of the automobile age, almost one hundred years ago. It has been estimated that over 300,000 persons die and 10 to 15
million persons are injured every year in road accidents throughout the world. Statistics have also shown that mortality in road
accidents is very high among young adults that constitute the major part of the work force. In order to overcome this problem there
is need of various road safety strategies, methods and counter measures. The survey was conducted on different causes of death due
to injury.

II. METHODOLOGY

Power BI Apps are the crucial components at user side where viewing and accessing of dashboard through some applications such
as Power Apps, Mobile Power BI...etc., Power BI connectors leads crucial role in getting data from the database and other sources
using connector application such as database engines, Azure Consumption Insight Connector...etc. The general operations of
Microsoft Power BI are as follows: 1) Get the Data from Required Data Source2) Analyse the data by means of connectors and
gateways of organization3) Build the Report by means of Different Visuals and Filters4) Publish the Report into web through Power
BI Desktop5) Edit the report if any changes are needed and make shareable by means of publishing on to web option for creating
embed URL 6)Access the report data from different applications of Microsoft such as Power Apps, Mobile Power BI 7) Refresh the
data using different gateways of Organization for updating the dashboard. In this paper, we discussed on process model and Visuals
of the Power BI tool and interactive data visualization technique for analysis and design of educational institution data visualization
using Microsoft Power BI tool.
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1) Data Collection: Data Collection is the process of gathering and measuring information on targeted variables in an established
systems, which then enables one to answer relevant questions and evaluate outcomes.

2) Data Storage: Power BI uses two primary repositories for storing and managing data: Data that is uploaded from users is sentto
excel sheet.

3) Data Cleaning: Once the data is stored into power BI it is important to clean and transform data before you build any
visualizations or reporting .This is essential step in building quality visualization. Cleaning and transforming data enables to
build visualizations from sound and clean data. If it is not done diligently visualization will not behave as we except

4) Data Analysis: Data analysis is a process of inspecting, cleaning, transforming and modelling data with the goal of discovering
useful information, informing conclusions and supporting decision making We use DAX (Data Analysis Expressions) for Data
Manipulation and working on the data.

5) Visualization: In this process we convert manually data into visualization is to visually display collected data by using various
charts, graphs or other visualization types.
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Flow Chart

E)ata Collection | :>| Stored into ExceE Data Cleaning with the help
of Oracle SQL developer

Visualization <: Data Analysis using DAB<): Import data into Powe@

II1. CREATING A REPORT OR A DASHBOARD

Requirement

KPI= Total casualties and Total Accident values for Current year and YoY growth.--> so Insight is as respect to the last year
the current year has been reduced by -11%.

KPI= Total casualties by Accident Severity for Current year and YoY growth. --> It is decrease the total accidents have been
decreased by 11%

KPI= Total casualties with respect to vehicle type for current year --> we can see tht car is one particular vehicle type which is
creating maximum number of accidents are offered due

Area Chart- Monthly Trend showing comparison of causalities for current year and previous year

Causalities by Road Type for current year-->> We can say most of the causalities in single carriageway road.

Current year Casualties by Area/Location & by Day/Nigh

Total Casualties and Total Accidents by location.

Connection Data with Power BI

Home Tab -> Get Data -> Click on Text/CSV or Excel -> Choose File -> Open
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When we click on the open button, a new dialogue box will get open. In which, following delimiter can be selected to extract the

data— » Comma ¢ Colon * Equal sign * Semicolon ¢ Space ¢ Tab ¢ Custom ¢ Fixed with

P Search

road accident report - Power Bl Desktop

File

Home Help Table tools Measure tools

&
New Quick

measure measure

& Name
(R) Home table | Data v

% Format‘ v

$+%

e \

B pata category | Uncategorized v

Structure Formatting Properties Calculations o~
ol X |1 Measure = r vl «
1 To use special characters in a measure name, enclose the entire name in brackets ( {] ) and add a ] to any ciosing brackets in the name. o
| 2] Accident Index | Accident Date Day_of Week  Junction_Control Junction_Detail Accident Severity  Llatitude  Light Conditions  Local Authority (District)  Carriageway_Hazards S
BS0000139 Thursday, April 8, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight Kensington and Chelsea None &
&5 BS0000158 Thursday, April 22, 2021 Wednesday Give way or unco T or staggered junction Slight Kensington and Chelsea None
BS0000188 9, 2021 Wednesday T or staggered junction 51.495363 Kensington and Chelsea None
BS0000331 5,2021 Wednesday T or staggered junction 51.487745 Kensington and Chelsea None
BS0000367 Thursday, July 29, 2021 Give way or uncontrolled T or staggered junction 51.493134 Kensington and Chelsea None
BS0000524 Thursday, October 28, 202 Give way or unco T or staggered junction 51.488958 Kensington and Chelsea None
BS0000531 Thursday, October 28, 2021 Wednesday G y or uncontrolled T or staggered junction 51.499355 Kensington and Chelsea None
BS0000551 Thursday, October 28, 2021 Wednesday G y or uncontrolled T or staggered junction Slight 51.497911 Kensington and Chelsea None
BS0001040 Thursday, January 7, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight 51.505685 Westminster None
BS0001071 Thursday, February 11,2021 Wednesday Give way or uncontrolled T or staggered junction 51.485691 Westminster None
BS0001356 Thursday, March 25, 2021 Wednesday Give way or uncontrolled T or staggered junction 51.551629 Camden None
BS0001370 Thursday, April 8, 2021 Wednesday Give way or uncontrolled T or staggered junction Kensington and Chelsea None
BS0001374 Thursday, April 8, 2021 Wednesday Give way or uncontrolled T or staggered junction Camden None
850001386 Thursday, April 8, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight Westminster None
BS0001444 Thursday, April 22, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight 51.534472 Westminster None
BS0001621 Thursday, May 20, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight 51.532526 Brent None
BS0001891 Thursday, July 1, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight Westminster None
BS0001921 Thursday, June 24, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight Camden None
BS0001930 Thursday, July 8, 2021 Wednesday T or staggered junction Camden None
850002086 Thursday, August 5, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight 1.528382 Camden None
BS0002092 Thursday, August 5, 2021 Wednesday Give way or uncontrolled T or staggered junction Slight 1526805 Camden None v
< >

Table: Data (307,973 rows) Column: Measure (0 distinct values)

Here we have two options: Edit and Load. 1. Edit will take take us in Power Query editor page. Where we can do necessary
formatting, calculation and rearrange data. Then click on close & Apply. Data will be upload into the Power bi desktop 2. Load will
directly upload the data into PowerBI Desktop

C. Power Query

Power Query act as an “ETL” tool for Power Bl i.e. it Extracts data from one or multiple sources, Transform that data and finally
Load it into Power BI environment. It also facilitates an “Applied Steps” feature, where whatever we do, will get recorded as steps
and upon updating the source data, all those steps will get applied to them automatically and this way the creator of the report needs
not to repeat the steps. Power query editor is a separate window which can be accessed by either of the following ways: 1. Power BI
window Home -> Get Data -> Choose the respective data source -> Browse the file -> “Edit”. (Here “Edit” button will open Query
editor). 2. Power BI window Home -> “Edit Queries”

J | EJ = | road accident report - Power Query Editor - [=] ><
B o Transtorm Add Column View Tools Help (=]
1 =3 Jx = Table.ReplaceValue(#"Changed Type","fetal","fatal”,Replacer.ReplaceText,{"Accident_Severity”}) ~ Query Settings x
=8 [E=] Accident Date ~ ] AB Day_of_week ~] AB Junction_Controt ~ ]| AB Junction_Detait ~| A8, <+ PROPERTIES
1 BS0000001 1/1/2021 Thursday Give way or uncontrolled T or staggered junction Name
2  B50000002 1/5/2021 Monday Give way or uncontrolied Crossroads 2 Dt
> B50000003 1/3/2021 Sunday Give way or uncontrolied T or staggered junction Al Properties
4 BS0000004 1/5/2021 Monday Auto wraffic signal T or staggered junction e Aveiion erere
5 850000005 1/6/2021 Tuesaay Auto traffic signat Crossroads
&  B50000006 1/1/2021 Thursday Give way or uncontrolied T or staggered junction SEimz
7 850000007 1/8/2021 Thursday Give way or uncontrolied T or steggered junction Nevigaton
s  BS0000008 1/2/2021 Friday Auto tratfic signal Crossroads Promoted Headeo
5 850000009 1/7/2021 Wednesday Give way or uncontrolied T or stagsered junction Chesos s
| > Replaced value
1/10/2021 saturday Auto traffic signal Crossroads
1/7/2021 Wednesday Auto traffic signat Crossroads
1/16/2021 Friday Auto wratfic signal Crossroads
1/12/2021 Monday Data missing or out of range Not at junction or within 20 metres
1/9/2021 Friday Give way or uncontrolied T or staggered junction
1/17/2021 ssturday Give way or uncontrolied T or staggered junction
1/25/2021 sunday Auto traffic signal Crossroads
1/26/2021 Monday Give way or uncontrolied Crossroads
1/26/2021 Monday Data missing or out of range Not at junction or within 20 metres
1/19/2021 Monday Give way or uncontrolied T or staggered junction
1/27/2021 Tuesday Data missing or out of range Not at junction or within 20 metres
1/21/2021 Wednesday Give way or uncontrolied T or staggered junction
1/22/2021 Thursday Give way or uncontrolied T or staggered junction
23 850000023 1/31/2021 saturday Auto wrafric signal Crossroads
24  BS0000024 2/3/2021 Tuesday Give way or uncontrolied T or staggered junction
25  B50000025 1/31/2021 saturday Give way or uncontrolied T or staggered junction
26 BS0000026 1/31/2021 ssturday Give way or uncontrolied T or staggered junction o
27 850000027 1/29/2021 Thursday Auto traffic signal Crossroads
28 < >
21 COLUMNS, 999+ ROWS  Column profiling based on top 1000 rows PREVIEW DOWNLOADED ON SUNDAY, APRIL 9, 2023
Sy B cr m O € = @8 O W @ E ~ e Tacm T
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D. Data Modelling

Data modelling is the process of analysing and defining all the different data your business collects and produces, as well as the
relationships between those bits of data. Data modelling concepts create visual representations of data as it’s used at your business,
and the process itself is an exercise in understanding and clarifying your data requirements.

(= road accident report - Power Bl Desktop L Search sgnin @ - B8 x
File Home Help
i & 5 H A A (r A &l
= B @
GaBhbE® [ B =5 & 4 A4 | Al ¢
Get  Excel Data SQL Enter Dataverse Recent Transform Refresh Manage New  New New Manage View Q&A Language Linguistic Publish
datav workbook hubv Server data sourcesv | datav relationships ~ measure column table roles  as setup v schemav
Clipboard Data Queries Relationships Calculations Security Q&A Sensitivity Share N
1 Measure = r v
W | X v K K
$ To use special characters in a measure name, enclose the entire name in brackets ( [] ) and add a ] to any closing brackets in the name. v o
i G
T @
= — [}
5 Data o calendar o =
2
Accident Date 3 Date
Accident_Index B month )
Accident_Severity [ 1 B ver
v
Carriageway_Hazards :
D *E
Jun Collapse
Jun
Y La
Light_Conditions
Collapse
All tables II
——+ 100% () B3
Iv. REPORT
A.  Report View (Interface)
File Home Insert Modeling View Optimize Help
GeEBhEe b P AdAdZ B & )
= X ® K st 4 LL i
Get Excel Data SQL Enter Dataverse Recent Transform Refresh New Text More New  Quick Publish
datav workbook hubv Server data sourcesv datav visual box visualsv measure measure
Clipboard Data Queries nsert Calculations Sensitivity Share A
il «  Visualizations » Data »

= [
LA > BF calendar

EMEE N V=C-

P QA M R i 2

Build visuals with your data MFLEOoE ( Aecident Severs

Select or drag fields from the Data pane onto the report canvas. Q 8 | ca,,;age;ayjm
BSEEBERPE O B ¢ Accident co...
0 R QW2 O B o casualties
& D Day_of_ Week

Accident Date

L Accident_Index

Junction_Control
Cross-report
Allows other repo
drillthrough destination

Junction_Detail

tstousethispageasa e T 5T e

vim unougn Light_Conditions
Cross-report (@0 [ {BB; Light_Conditio...
= \7' Auth: /..
Keep all filters L) Local Authority

0 3 Longitude

OJ ﬁ Measure

O 3 Number_of Ca...
Page 1 Page 2 II MY Numher af Va

Add drill-through fields here

© IJRASET: All Rights are Reserved | SJImpact Factor 7.538 | ISRA Journal Impact Factor 7.894 | 693



International Journal for Research in Applied Science & Engineering Technology (IJRASET)
ISSN: 2321-9653; IC Value: 45.98; SJ Impact Factor: 7.538
Volume 11 Issue X Oct 2023- Available at www.ijraset.com

B.  Power Bi Desktop Filters

1) Visual Level Filter: This gets applied to only to the active visual.

2) Page Level Filter: This gets applied to all the visuals in the existing page.

3) Report Level Filter: This gets applied to all the visuals in all the existing pages in the report.

FILTEIRS

C. Types Of Visualization In A Power Bi Report
* Area * Stacked Area * Bar/Column ¢ Clustered Bar/Column ¢ 100% Stacked Bar/Column ¢ Combo * Ribbon * Tree map * 3D Map
* Filled Map ¢ Card/KPI * Slicer * Table * Matrix * Doughnut * Funnel * Gauge ¢ Line ¢ Pie ¢ Scatter * Waterfall

D. Power BI Dashboard

1) This is a single page view of overall story through visualizations. For detailed summary, user can visit the related reports.

2) Dashboard is a feature of Power BI Service. This is unavailable in Power BI Desktop. A pro license if needed to access Power
BI Service.

E.  Output of Road Accident Analysis

ROAD ACCIDENT ANALYSIS

Total CY casualties Total CY Accidents CY Fatal Casualties CY Serious Casualties

195.7K Qe oK LAl B 0K e

CASUALTIES BY VEHICLE CY casualties by Road_Type CY casualties by urban/rular Casualties by Location
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V.  RESULTS

Total CY Casualties 182.6k decreases -11.9% Total CY Accident 144.4k decreases -11.7% CY Fatal Casualties 2.9k decreases -
32.5% CY Serious Casualties 27.0k decreases -16.2% CY Slight Casualties 165.8k decreases -10.6%

VI. CONCLUSION

Overall, the objectives of this research were met. Through visualization, data analysis aids pupils in comprehending concepts.
Various technologies are available to undertake corporate data analysis, however the Power BI visualization technique is the most
popular technique for learning the fundamentals of data analysis. With the help of the visualization technique, data interpretation
and data representation may be done quickly and easily. This strategy is highly useful for stronger conceptual design.
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